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Chapter 1. Getting Started                                                                 

“Hey, Logy, whatcha doing?”

“What’s it look like I’m doing.  I’m 
cleaning the windows so we can get started 
on our new adventure.”

“Can’t you leave the housekeeping 
until later.  We’ve got Logo work to do!”

“I don’t like dirty windows!" replied 
Logy.  "I don’t care if they are on the house 
or on the computer.  If we’re going to 
discover new things to do with Logo, we’re 
going to have clean windows.

“Did you know that Ernestine brought along her whole 
family, over 1,000 turtles.  And you can now play music 
through your new sound card.  You can even use Logo to make 
up your own Windows stuff for your friends to use.  Just wait 
until you see the trouble you can get into!”

“Yeah, yeah, yeah” Morf said, bounding around excitedly.  
“What do we have to do?  When can we get started.  I’ve got 
lots of ideas I want to try out!”

________________________________________________

Which Logo Are You Using
First things first!
This chapter is for those using MSW Logo, the Logo for 

Windows package on the CD that comes with this book. It tells 
you all about the MSW Logo windows and menus. You don’t 
need to know all about these to get started. Just remember that 
the information is here when you need it.
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Those using UCB Logo can turn to the appendix for more 
on how to get started. If you’re using or installing another Logo 
package, check out the books that came with your software.

________________________________________________

Installing MSW Logo
The first thing you need to do is install Logo on your 

computer. Make sure that you select the correct MSW Logo 
kit from the CD that came with this book.

msw32b52.exe This is the 32bit kit for Windows 95 and
Windows NT.

msw32s52.exe This is for those running Win32s in
Windows 3.1x. Win32s is not included.

msw16b52.exe The 16bit kit for those running Windows
3.1x or Windows 95 in 16-bit mode.

msw16s52.exe This is for those running Windows 3.1 on
IBM XT and other’286 computers. 

mswsrc52.exe The source kit.

mswtut52.exe An on-line video tutorial for beginners
3.5 MB compressed.

1. Turn on your computer and get Windows started.

2.  Double-click the File Manager in Windows 3.1 or 
Windows Explorer in Windows 95/98.

 Double-click means to quickly press the left mouse button 
two times. But you already knew that, didn’t you?

3.  Double-click on the MSW Logo kit to be installed. Then 
follow the instructions on the screen.

________________________________________________

MSW Logo 
Directories

When MSW Logo is installed, three directories are set up:
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•  Mswlogo: This is the main directory or folder. This is 
the where you will save your own procedures. You 
can also make a separate procedures directory if you 
want.

•  Examples: This directory includes a number of 
subdirectories with different types of MSW Logo 
sample procedures. Be sure to read the README. 
TXT file. This provides a description of all the 
example procedures.

MSW Logo procedures are regular ASCII text files 
that you can read using a text editor or word 
processing software. If you change them at all, it’s 
best to save them using another name. 

•  Logolib: This is a directoty of special Logo primitives 
— that’s the Logo word for commands — used by 
MSW Logo.

You may want to copy these directories from the CD onto 
your own hard drive.

\graphics This directory has all the graphics -- BMP 
or TIF -- files the book talks about.

\procs This directory contains the procedures
from the book.

What’s in the other directories?

\projects This directory contains additional projects
and activities you can try. They are listed
by chapter. Check out the Appendix for a
list of what’s in each subdirectory.

\logo A list of Logo resources where you can
find out all about Logo. There are also
Logo demo files you can explore.
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To see a few of the things that MSW Logo can do, run the 
MSW Logo Demo.

1. Left-click on Help in the menu bar.  (That means to press 
the left mouse key.)

2.  Select Demo to get a preview of MSW Logo.

________________________________________________

Installing UCB 
Logo

UCB Logo is also provided on your CD. It was developed 
by Brian Harvey, a long-time Logo fan and developer, and 
some of his University of California graduate students. This is 
what George Mills used to develop MSW Logo.

UCB Logo is best suited to those more advanced users 
who are familiar with DOS and DOS file structures. It is more 
like “classic Logo” in that it does not include multiple turtles, 
music, or multimedia features. 

Two UCB Logo packages are included on the CD:
ucblogo_seax.hqx Compressed files for the Macintosh.
blogo.exe Compressed files for the PC.

Blogo.exe includes three Logo programs:

•  ucblogo.exe runs in MS-DOS on 286-and-up PCs. It 
uses extended memoryif you have it, so you can run 
large Logo programs.

•  bl.exe runs on any MS-DOS PC, but is limited to 
640K.

•  ucbwlogo.exe runs on Windows 95 and Windows NT 
only.

Copy the UCB Logo file for your computer into an empty 
directory on your hard drive and then inflate it. To install UCB 
Logo, type install. Read the Readme and UCBLogo.txt files 
for more information on how to setup and run UCB Logo.

________________________________________________
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Opening Logo When you install MSW Logo, Windows puts it in its own 
program group or folder. Left-click on the program group or 
folder and there’s the MSW Logo icon in its own little window. 

Double-click on the Logo icon in that little window to 
open MSW Logo.  The MSW Logo Screen appears.

________________________________________________
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Parts of the 
Screen

There's Ernestine sitting at right in the middle of her 
playground. Ernestine looks like a pointed arrow but she's 
really a turtle who does just about anything you ask her to do. 
If she doesn’t understand, she’ll tell you.

First, let’s take a look at the rest of the MSW Logo screen.

It’s like many Windows screens.  The Title Bar is at the 
top.  This tells you what window you’re looking at.  

The Menu Bar is right below the Title Bar. It holds the 
names of menus we’ll describe a bit later.

Down below the playground is the Commander window. 
This is where the action is.

  

Title Bar
Menu Bar

Turtle’s Playground

Turtle

Commander
Input Box
Command Box
Command Buttons

 Window
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The big space in the Commander 
window is the Command Box. This box 
keeps a list of what’s going on. If 
something goes wrong, you’ll see a 
message here. 

Below the Command window is the 
Input Box.  This is where you type your 
instructions to the turtle.

Over on the right side, there are a bunch 
of buttons that can make things a little 
easier. 

________________________________________________

Commander 
Buttons

Morf loves buttons and things. So here’s a list of the 
Commander buttons. We’ll talk more about each of them later 
as we go along.

Halt
This stops the Logo action right away. It does the same 

thing that the HALT command does.

Trace
This turns the Trace command on. Left-click on it to turn 

the Untrace command on.

Pause
Logo stops the action temporarily and waits for the 

Continue command.

Status
The Status button brings up a Status window that tells you 

what’s going on.

Yield
This tells Logo not to allow other programs to run while 

Logo is running.
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Reset
This button is like the Clearscreen command. It resets or 

clears the screen.

Execute
This is like pressing the Enter key. It tells the turtle to run 

or execute your procedure.

________________________________________________

Commander 
Window

The Commander window is separate from the MSW Logo 
window. That means you can move it around, make it smaller 
or larger, or you can change it into a little icon. We work with 
this window a lot. So if you want to practice moving it around 
or changing its size, go ahead.

1. Left-click in the Title Bar where you see the word, 
Commander.  

The title bar of the Commander window changes 
color.

2.  With the cursor in the Title Bar, press and hold the left 
mouse key down. Then drag the Commander window 
around the screen.

The Commander window moves with the mouse.

3.  Move the Commander window back where it is supposed 
to be and release the mouse button.

You’re back where you started.

________________________________________________

MSW Logo Menus
There are five menus in the Menu Bar. You know what a 

Menu is, don’t you? You left-click on the word and up pops a 
list of choices. MSW Logo menus give you lists of commands 
you can execute. We describe the commands throughout this 
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book. We also tell you to look back here to read about the menu 
commands.

________________________________________________
SPECIAL NOTE: When we want you 

to pay special attention to something, we 
use this Special Note box. Right now, we 
have a special note about this book that we 
want you to read before we get started.

When reading about menus and what 
you can do with them, you may see things 
like File/Edit or Edit/Copy. This is just

a short way of saying open the File menu and left-click on 
Edit, or open the Edit menu and left-click on Copy. 

Sometimes you may see instructions like File/Edit/All. 
You got it. That means open the File menu, select Edit, and 
then left-click on All in the box that appears.

________________________________________________

File This menu shows you a list of things you can do with your 
procedures. There are also commands that do the same thing. 
You’ll read about these as they come up later one.

Load...
Left-click on Load to display the Open dialog box in 

which you can select the procedure to load, just like you do 
with any other windows program. 

        This is the File menu.
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Save
This saves any procedures that you may have loaded along 

with any new procedures you wrote and any procedures you 
changed. If you are saving new procedures, the Save As dialog 
box is displayed. Give the procedure a name in the File Name: 
box. Left-click on OK to save it.

Save As...
The Save As dialog box is displayed. This gives you the 

chance to save any procedures that you have in memory under 
a new name. Type a name for your procedure in the File Name: 
box. Left-click on OK to save it.

Edit
The Edit Procedure dialog box is displayed showing any 

procedures currently in memory. Either type the name of the 
procedure you want to edit in the box above the list of 
procedures or left-click on the procedure name. The name you 
select is then displayed in the box. Left-click on OK to display 
the procedure in an Editor window.

Left-click on All to display all the procedures in 
memory. You already know what Cancel means, right? If not, 
try it out and see.

Erase
Erase acts a lot like Edit except that the Erase Procedure 

dialog box is displayed showing any procedures currently in 
memory. Either type the name of the procedure you want to 
erase in the box above the list of procedures or left-click on 
the procedure name. The name you select is then displayed in 
the box. Left-click on OK to erase the procedure. Left-click 
on All to erase all the procedures in memory. 

Exit
Left-click on Exit to leave MSW Logo.

________________________________________________

Bitmap Bitmap is a computer term that describes the pictures you 
create. This menu includes commands for loading, saving, and 
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printing the pictures that you create. There is a wide variety of 
Bitmap commands that you’ll learn about as you move through 
this book. Here’s what the menu commands do.

New
Left-click on New to erase the picture that is displayed on 

the screen. The turtle remains where it stopped.

Load
Left-click on Load on the Bitmap menu. The Open dialog 

box is displayed with a list of bitmaps you can load. These are 
graphic files with the *.bmp extension.

Save
Left-click on Save to save the current screen as a picture 

file. The entire screen is saved making this a very big file. To 
reduce the size of the file, reduce the Active Area as described 
below.

Save As...
The Save As dialog box is displayed. This gives you the 

chance to save a picture under a new name. Type a name for 
your picture in the File Name: box. Left-click on OK to save it.

Print
Left-click on Print to send the current screen to your 

printer. This works like the regular Windows command. A 
dialog box is displayed that lets you change your printer setup 
if you want.

Print Setup
This is just like the regular Windows Print Setup option. 

You can change printers, paper size, and all sorts of other 
things here.

Set 
Using the Set menu, you can change the type of letters 

and numbers that Logo uses by setting the “font” in this menu. 
You can also set colors. There’s a lot more on fonts and colors 
in the Color, Music, and Pizzazz chapter.
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Pensize
Left-click on Pensize to change the size of the turtle’s pen. 

You can select on of the pictures of different line thicknesses 
or use the slide to get just the line thickness you want.

Font
You can change the font that is used with the Label 

command to display text on the graphics screen. This does 
nothing for how text is displayed in the Editor and Commander 
windows. 

Left-click on Font to display a list of all the fonts you 
have installed. You know what a font is, don’t you? It’s a set 
of letters, numbers, and punctuation marks in one size and 
style. The Font dialog box gives you the choice of font sizes 
and styles from which to select.

PenColor

FloodColor

ScreenColor
These three options each display the same basic window 

from which you can select the color of the turtles pen, the color 
the turtle uses to “flood” or fill closed shapes, and the color 
for the screen background.

Zoom You can Zoom in on your pictures to make them fill more 
of the screen. Or you can Zoom out so that you can see more 
of the screen’s active area.

In
Go ahead. Left-click on the Zoom menu and then on In. 

What happens? Left-click on In again. And again. See what 
happens? 

Normal
Now left click on Normal to get things back to the way 

they should be. Then try doing the same thing only zoom out. 

Out
Zooming out is very handy if your screen does not display 

all of the pictures from the procedures on the CD. Just zoom 
out to see the whole thing.
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________________________________________________

Help If you have questions about how to do something in MSW 
Logo, you can left-click on Help.

   

The Help Menu gives you some choices:

Index
Left-click on Index to see a list of the chapters in the MSW 

Logo On-line Help.

MCI
That stands for Media Control Interface. This is a group 

of special commands for controlling sound, video, and other 
multimedia devices. There are some good examples of these 
commands included in the Examples directory. We talk about 
them later in this book.

Using Help
 This is a neat section. It will help you if you need help 

using Help. 
Does that make sense?

Tutorial
There is a video tutorial on the CD that comes with this 

book. Other than that, this book will have to do.

Demo
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Select Demo to see a neat demonstration of some of the 
things that MSW Logo can do.
Examples

Examples displays the Readme file in the MSW Logo 
Examples directory. You can discover lots of other things you 
can do with MSW Logo.

Release Notes
This tells you all about the things that MSW Logo has to 

offer. It’s the same as the MSWLOGO.TXT file in your MSW 
Logo directory. 

About Logo
This tells you who developed MSW Logo. It also provides 

e-mail addresses where you can contact the developers.

________________________________________________

Ready to Start Ready to get started?  Fine, it’s time to...


